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e Safety precautions
Before you use the printer, carefully read the User Guide to ensure that you use the printer
correctly. Be aware that the content complies with the standards at the time the User Guide
section related to safety, including usage and safety precautions, was created.

e Modifications
To ensure product safety, modification of the CITIZEN CZ-01 printer and CITIZEN CZ-01 printer
driver is prohibited.

e Copyright
The copyrights, trademark rights, and other intellectual property rights related to documents and
programs included with this product are the property of CITIZEN SYSTEMS JAPAN CO., LTD.
and other rights holders. You cannot copy and use these items without the permission of
CITIZEN SYSTEMS JAPAN CO., LTD. except where permitted by applicable laws.

Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the
United States and in other countries.
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Chapter 1 Installation

Installation procedure

The installation procedure is made up of three steps.
The details of each step are explained below.

[ Step 1 Prepare the printer and computer — “1.1 Prepare the printer and computer” ]

At this point, the USB cable is not
yet connected.

[ Step 2 Install the driver package — “1.2 Install the driver package” ]
Q ﬁ Install the driver package.
[ Step 3 Install the printer driver — “1.3 Install the printer driver” ]

USB cable

Connect the USB cable, switch on the printer, and
then install the printer driver.
After installation is complete, restart the computer.

CITIZEN SYSTEMS JAPAN CO., LTD.
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1.1 Prepare the printer and computer

Make sure that the printer power is off.

Prepare a USB cable. However, do not use the USB cable to connect the printer and computer at
this time.

Log in to Windows as an administrator. The following explanation presumes that the operations are
carried out with administrator privileges.

CAUTION:

The display settings of the computer must be set as follows. If the settings differ from the
following, the printing preferences screen and other items may not fit in the display area.

- Resolution: At least 1280x800
- Size of text and other items (DPI): 100%

1.2 Install the driver package

Open Windows Explorer, and then click the corresponding drive.

Select one of the following driver package folders.
Driver package folder¥CITIZEN CZ-01_Driver

[} B - | CITIZEN CZ-01_Driver

File Home Share View 0
N » CITIZEN CZ-01_Driver w @ Search CITIZEN CZ-01_Driver 0
Name Date modified Type Size
Dec File folder
DriverPackage File folder
[Z] Driverlnstall Windows Cormma... 1KB
|j ReadMe_Install_English Text Document 1KB
|j ReadMe_lnstall_Japanese Text Document 1KB
3 items =

Figure 1.2.1 Driver Package folder

CITIZEN SYSTEMS JAPAN CO., LTD.
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In the selected folder, double click the following file: Driverlnstall. CMD. (Depending on your usage
environment, the .CMD extension may not be displayed.)

The driver package installer appropriate for your operating system (32-bit or 64-bit) is selected
automatically.

B E B - | OTZEN CZ-01 Driver

File Home Share View o
™ > CITIZEN CZ-01_Driver v O Search CITIZEM CZ-01_Driver @
~
MName Date modified Type Size
Doc File folder
DriverPackage File folder
Drriverlnstall Windows Comma... 1KB
= ReadMe_Install_English Text Document 1KE
D ReadMe_Install_Japanese Text Document 1KB
3 items =

Figure 1.2.2 Installation file

When you start the installer, a window appears for selecting the language that will be used during the
installation. After you select the language to use, click “OK”.

CITIZEM CZ-01 - InstallShield Wizard

Select the language for the installation from the choices below.

English {United States) ~
Cancel

Figure 1.2.3 Language selection screen

Click “Next >” when the Installation Wizard screen appears.

jis CITIZEN CZ-01 - InstallShield Wizard

Welcome to the InstallShield Wizard for
CITIZEN CZ-01

The InstallShield{R) Wizard will install CITIZEN CZ-01 on your
computer. To continue, dick Next.

WARNING: This program is protected by copyright law and
international reaties.

< Back Cancel
Figure 1.2.4 Installation Wizard start screen

CITIZEN SYSTEMS JAPAN CO., LTD.
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Click “Install” when the installation is ready.

ji§ CITIZEN CZ-01 - InstaliShield Wizard

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Installshield

< Back ‘1 Cancel
Figure 1.2.5 Installation start confirmation screen

When the installation starts, a screen appears that shows the installation status.

i CITIZEM CZ-01 - InstallShield Wizard

Installing CITIZEN CZ-01
The program features you selected are being installed.

Flease wait while the InstallShield Wizard installs CITIZEN CZ-01. This may
take several minutes.

Status:

Instalishield

< Back Mext =
Figure 1.2.6 Installation status screen

CITIZEN SYSTEMS JAPAN CO., LTD.
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When a User Account Control dialog box appears, click “Yes”.

User Account Control X

Do you want to allow this app from an
unknown publisher to make changes to your
device?

e ] [ g
v il s T sl ol 0 R A
SNCITIZEN CZ-01.msi

Publisher: Unknown
File origin: Hard drive on this computer

Show more details
( - ] "o |

Figure 1.2.7 User Account Control

Click “Install” when the Windows Security confirmation display appears.

EH Windows Security

Would you like to install this device software?

Mame: CZ-01
;:;t_, Publisher: CITIZEM SYSTEMS JAPAN CO,, LTD.

Abways trust software from "CITIZEN SYSTEMS ' Don't Install
JAPAN CO,, LTD.".

) You should only install driver software from publishers you trust. How can | decide which device
software is safe to install?

Figure 1.2.8 Windows Security confirmation

Installation of the driver package starts. Wait until installation finishes.
Click “Finish” when the Installation Wizard completion screen appears.

ji§ CITIZEN CZ-01 - InstallShield Wizard

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed CITIZEN
CZ-01 Click Finish to exit the wizard.

ot ) o

Figure 1.2.9 Finish of Installation Wizard

CITIZEN SYSTEMS JAPAN CO., LTD.
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1.3 Install the printer driver

Use the USB cable to connect the printer and computer, and then switch on the power of the CITIZEN
CZ-01 printer.  After the printer is recognized, installation of the driver starts.
*For information on the connection, refer to the User Guide of the printer.

In Windows 7, if driver installation starts, the following message appears in the taskbar: “Installing
device driver software”.
In Windows 10, this message does not appear. Proceed to page 8.

Click here for status.

[ M 1nstalling device driver software

Figure 1.3.1 Driver installation message

If you click on this message, the Install driver software screen appears and displays the installation
status of the driver. If Close is clicked, this screen closes.

__ Driver Software Installation =3
Installing device driver software
Phata Printer {_ Searching Windows Update...

Obtaining device driver software from Windows Update might take a while.
Skip obtaining driver software from Windows Update

Figure 1.3.2 Installing the driver software

*About the “Skip obtaining driver software from Windows Update” option

If your operating system is configured to obtain driver software from Windows Update, it may take time
for installation to complete because the process searches for drivers from Windows Update first. You
can reduce the time until the completion of installation by choosing to skip obtaining driver software
from Windows Update. (Depending on your operating system, it may take some time until installation
is complete.)

From the Driver Software Installation dialog box, click “Skip obtaining driver software from Windows
Update”.

. -
. Driver Software Installation =3
Installing device driver software

Photo Printer e Searching Windows Update...

ight take a while.
Skip obtaining driver software from Windows Update

Figure 1.3.3 Option to skip obtaining driver software from Windows Update

CITIZEN SYSTEMS JAPAN CO., LTD.



[CITIZEN CZ-01 Printer Driver] Instruction Manual (For Windows 7, 10) '

A confirmation dialog box appears. Click “Yes”.

Driver Software Installation @

i Do you want to skip getting driver
~ software from Windows Update?

Windows Update provides the latest available driver
software which may work better for your device, You
can check Windows Update later for the latest driver
software. If you skip your device may not function at
all.

Figure 1.3.4 Confirmation to skip getting driver software from Windows Update

After the installation is complete, the message “Your device is ready to use” is displayed in a pop-up
on the taskbar.

Device driver software installed successfully.

[ W ; Your device is ready to use % *

Figure 1.3.5 Installation complete message

If you click on the message, the Driver Software Installation dialog appears, and the “Your device is
ready to use” message appears. Click “Close”.

(If the Driver Software Installation screen is open when installation starts, the abovementioned taskbar
message is not displayed.)

_'_! Driver Software Installation @
Your device is ready to use

USE Printing Support »j’ Ready to use
CITIZEN CZ-01 «f Ready to use

Figure 1.3.6 Completion of driver software installation

CITIZEN SYSTEMS JAPAN CO., LTD.
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Click “Start”, and then click “Windows System” -> “Control Panel” to open the Control Panel.
In Windows 7, click “Start”, and then click “Control Panel” to open the Control Panel.
In Control Panel, click “View devices and printers”.

E& Control Panel = m]

« v 4 E» Control Panel + v|® | Search Control Panel )

Eile Edit View Tools

Adjust your computer's settings View by:  Category ™
System and Security 3 User Accounts
Review your computer's status & Change sccount type
Save backup copies of your files with -
File Histary

Appearance and

Backup and Restore (Windows 7) Personalization

i' ! Network and Internet
View network status and tasks
./ Hardware and Sound

ﬁ‘ View devices and printers

Add a device

Clock and Region
Change date, time, or number formats
Ease of Access

Let Windows suggest settings
Optimize visual display

Ol

Adjust commonly used mobility
settings

<. Programs
[‘] Uninstall a program
Get programs

Figure 1.3.7 Control Panel

In Devices and Printers, make sure that “CITIZEN CZ-01" is present.

Note: In Windows 10, when the printer is offline (the printer is not on and connected), the CITIZEN CZ-
01 icon is not displayed.

This completes installation of the printer driver.

&ty Devices and Printers

&« ~ A Fa <« Hard... » Devicesand Prin... v @ Search Devices and Printers »r
Add a device Add a printer Remove device = - (7]
~
CITIZEN CZ-01 Fax
v
q CITIZEN CZ-01  Model: CITIZEN CZ-01 Status:  Driver is unavailable
P Category: Printer

Figure 1.3.8 Devices and Printers screen

After the installation of the printer driver is complete, always restart the computer.

CITIZEN SYSTEMS JAPAN CO., LTD.
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In Windows 7, when the CITIZEN CZ-01 printer driver could not be installed correctly, the following
message appears in the taskbar: “Device driver software was not successfully installed”.

i ! Device driver software was not successfully installed * *
=Y Click here for details.

Figure 1.3.9 Message indicating that the driver was not installed

If you click on this message, the Install driver software screen appears and displays the message
“Device driver software was not successfully installed”. Click “Close”.

(If the Driver Software Installation screen is open when installation starts, the abovementioned taskbar
message is not displayed.)

When the driver could not be installed correctly, see the next section, “1.4 Install drivers for
unspecified devices”, and then install the printer driver.

_'_E Driver Software Installation @
Device driver software was not successfully installed

USE Printing Support +f Ready to use
CITIZEM SYSTEMS CZ-01 ¢ No driver found

What can [ de if my device did not install properhy?

Figure 1.3.10 When the driver was not installed correctly

CITIZEN SYSTEMS JAPAN CO., LTD.
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1.4 Install drivers for unspecified devices

If you connect a printer that is on to the computer before installing the driver package, a device is
created under “Unspecified” in Devices and Printers.

B Devices and Printers

&« ~ 4 % <« Hardware and Sound » Devices and Printers v | Search Devices and Printers yel
File Edit View Tools
Add a device Add a printer Remove device = v 0

L

Photo Printer

Photo Printer  Model: Photo Printer
! Category:  Unknown

Figure 1.4.1 Photo Printer under Unspecified

In such a case, use the following method to install the printer driver.

Furthermore, use the following method to install the printer driver if you use the standard installation
procedure (install the driver package, connect the printer, and then install the printer driver), but the
driver is not installed correctly, and a device is created under “Unspecified”.

1. Install the driver package
When the driver package has not yet been installed, install it by following the procedure in “1.2
Install the driver package”.
If you install the driver package, installation of the printer driver for the unspecified device completes
it automatically.

2. Installing a driver for an unspecified device
After installing the driver package, the driver installation procedure for an “Unspecified” device is
different for Windows 7 and Windows 10.
For Windows 10, refer to page 11.
For Windows 7, refer to page 12.

10
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In Windows 10:
1. Right-click “Photo Printer” of the “Unspecified” device in “Devices and Printers”, and click
“Remove device” from the pull-down menu.

B Devices and Printers

&« « A W « Hardware and Sound » Devices and Printers | Search Devices and Printers 2
File Edit View Tools
Add a device Add a printer Remove device = - 9

Create shortcut
I 9 Remove device I
Troubleshoot

Photo Printer

Properties

Photo Printer  Model: Photo Printer
! Category: Unknown

Figure 1.4.2 Delete “Photo Printer”

2. Disconnect the USB cable connected to the printer.
3. Restart your computer.
4. After starting up the computer, connect the USB cable again and turn on the printer.

In Devices and Printers, make sure that “CITIZEN CZ-01" is present.

Note: When the printer is offline (the printer is not on and connected), the CITIZEN CZ-01 icon is not
displayed.

This completes installation of the printer driver.

"7y Devices and Printers

<« “ 4 s « Hard.. > Devices and Prin... ~ © | SesrchDevicesand Printers 0
Add a device Add a printer Remove device = - o
~
CITIZEN CZ-01 Fax
v
CITIZEN CZ-01  Model: CITIZEN CZ-01 Status: Driver is unavailable
.Q_/b Category: Printer

Figure 1.4.3 Devices and Printers screen

After the installation of the printer driver is complete, always restart the computer.

11
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In Windows 7:
In Devices and Printers, under Unspecified, right click on “Photo Printer”. From the menu, click

“Troubleshoot”.

= - -
@Uv‘s‘,ﬁ <« Hardware and Sound » Devices and Printers
Add a device  Add a printer

4 Unspecified (1)

Create shortcut

° -
Troubleshoot
Properties 1

Photo Printer |

Model: Photo Printer

- Phato Printer
Category: Unknown

Figure 1.4.4 Photo Printer under Unspecified

The Install a driver for this device screen appears. Click “Apply this fix”.
The computer searches for a driver automatically, and then installs it.

=

@ [+& Devices and Printers

Install a driver for this device

The driver for CITIZEN SYSTEMS CZ-01 is not installed. Install the latest driver for the device.
[') Apply this fix J

= Skip this fix

Continue troubleshooting without applying this fix.

Cancel

Figure 1.4.5 Applying a fix

12
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If the driver is installed, the message “Troubleshooting has completed” appears. Click “Close the
troubleshooter” to close the troubleshooting window.

\‘j [ Devices and Printers

Troubleshooting has completed

The troubleshooter madie some changes to your system. Try atternpting the task you were trying
to do before.

Problems found
CITIZEN SYSTEMS CZ-01 doesn't have a driver Fixed (]

[-) Close the troubleshooter ]

= Explore additional options

View detailed information

Figure 1.4.6 Completing troubleshooting

In Devices and Printers, make sure that “CITIZEN CZ-01" is present.
This completes installation of the printer driver.

(=)o =)
v Tl

@'\Jv‘@ < Hardware... » Devices and Printers - | &,| Search Devices and Printers P |

Add a device Add a printer See what's printing Print server properties  » = - .@.
-

[ /
b iy &
CITIZEN CZ-01 i
CITIZEN CZ-01 State: @' Default Status: 0 document(s) in queue
1 / Model: CITIZEN CZ-01
' Category: Printer

Figure 1.4.7 Devices and Printers screen

After the installation of the printer driver is complete, always restart the computer.

13
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Chapter 2 Properties

You can configure various printer settings from the Properties of the driver. Make sure you
understand the contents well before changing settings. To use the properties, log in as an
administrator. Depending on the application you are using, you must perform this operation from the
print settings of the application.

2.1 Open the printer properties

1. Click “Start”, and then “Windows System” -> “Control Panel” -> start “Control Panel”
In Windows 7, click “Start” -> “Control Panel” -> start “Control Panel”

l Windows Media Codec Pack

Bl Windows Media Player

B Windows Powershell
. Windows System
= Command Prompt

Control Panel

File Explorer

Run

Task Manager

This PC

2. From the Control Panel, click “View devices and printers” to open the Devices and Printers

EE Control Panel — O

« v » Control Panel > v O Search Control Panel pal

File Edit Yiew Iecls

Adjust your computer's settings View by:  Category ¥
System and Security User Accounts
Review your computer's status ® Chinge account type

Save backup copies of your files with

File History o B Appearance and
Backup and Restore (Windows 7) | personalization
- -
¢ Network and Internet Clock and Redi
View network status and tasks »33 ock and Region

Change date, time, or number formats

Ease of Access
Let Windows suggest settings
Optimize visual display

wareand Sound
evices and printers
T e

Adjust commonly used mebility

settings
s Programs
[_l, Uninstall a program
Get programs

14
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w

. Right click “CITIZEN CZ-01" icon. From the menu, click “Printer Properties” to open the
Properties dialog box.

Note: In Windows 10, when the printer is offline (the printer is not on and connected), the
CITIZEN CZ-01 icon is not displayed.

B Devices and Printers

- v “+ Ha » Control Panel » Hardware and Sound » Devices and Printers v | | Search Devices and Printers o

Addadevice  Addaprinter  Seewhat's printing  Print server properties  Remove device - @

¢ See what's printing
: Set as default printer

Printing preferences

Printer properties
CITIZEN CZ-01

Create shortcut

) Remove device
Troubleshoot

Properties

CITIZEN CZ-01

Model:  CITIZEN CZ-01
! Category: Printer

Status: 0 document(s) in queue

4. The CITIZEN CZ-01 Properties screen appears.

= CITIZEN CZ-01 Properties

General Shaing Pots  Advanced Color Management Security

= |

Location: ‘ |

Comment:

Madel: CITIZEN CZ-01
Features
Color: Yes Paper available:
Double-sided: Mo (@x6)
Staple: No

Speed: Unknown

Maximun resalution: 300 dpi

Preferences... Print Test Page

15
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2.2 Print settings functions

If you select the basic settings from the Properties screen, you can change various print settings.

2.2.1 Layout

o —

Layout | Paper/Gualty  Option  Color Adustment | Printer Info

Adyaneed..

Cancel Aoply

Figure 2.2.1 Layout tab

Orientation

Set the print orientation to “Portrait” or “Landscape”.
For details, refer to “2.6 Orientation”.

Page Order
In the application, specify the order when multiple copies of an image are printed.

Example) Print order No.1 No.2 No.3

Front to Back

Back to Front

Page Format

Pages per Sheet
Set printing of the specified division size. In most situations, set “1”.

Example) Division size 1 division 4 divisions 9 division

16
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If you select “Advanced...

R —

2.2.2 Advanced options

Layout  Paper/Qualy Option  Color Adjustment | Printer Info

Qrientation:

Page Ogder:
| Front to Back ~|
Page Format
Pages per Sheet “ v‘
Draw Borders

[CITIZEN CZ-01 Printer Driver] Instruction Manual (For Windows 7, 10)

Figure 2.2.2.1 Advanced settings

Paper/Output

Paper Size

” on the Layout tab, you can configure various advanced options.

CITIZEN CZ-01 Advanced Options

= CITIZEN CZ-01 Advanced Document Settings
4] Paper/Output
: Copy Count: 1 Copy
E@ Graphic
2] D Image Color Management
I 1CM Method: |CM Handled by Host System
P ICM Intent: Pictures
£-ff Document Options
i Advanced Printing Features: Enabled
L. Pages per Sheet Layout: Right then Down
21§y Printer Features
Border: Disable
-------- Overcoat Finish: Glossy
Print Re-try: Enable
2inch cut: Disable
High quality mode: Disable
........ Decurling action: Auto

Sz

Figure 2.2.2.2 Advanced options tab

Specify the paper size. The paper size that can be specified depends on the media size that is

loaded in the printer. If the printer is offline, the loaded media size is assumed to be 4x6.

Loaded media

size Specifiable paper size Multiple layout
4x3 Enable
4x6+1)
4x4, 4x4.5, [4x6] Disable
4x3, 4.5x3, 4.5x4 Enable
4.5x82)
4x4, 4x4.5, 4x6, 4.5x4.5, 4.5x6, [4.5x8] Disable

The paper size in square brackets [ ] is the default paper size for the loaded media.

*1: Paper sizes that cannot be used for
printing are grayed out.

CITIZEN CZ-01 Advanced Options

e CITIZEN CZ-01 Advanced Document Settings

Paper/Output

dled by Host System

<: Enabled
ght then Down

Deed Picabln

Figure 2.2.2.3 Incompatibility media size
(Gray out indication)

*2: For paper sizes that can create
margins on the sides of the output results,
a warning appears.

CITIZEN CZ-01 Advanced Options

= CITIZEN CZ-01 Advanced Document Settings
(4.4, Paper/Qutput

EC
. (4.5x3)
=] @ Graphic (4.5%4)
B@ Image Colo (4.5x4.5)
H foee |CE M (4.5x6) by Host System

b [CM It (4.5
E| % Document Opti & %3) y

- Advanced P| & (4x) nabled
i Pages per Sl B (4x45) then Down
= % Printer Feats & (4x6)

Drrden T

Figure 2.2.2.4 Incompatibility media size
(Warning indication)

17
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Copy Count
You can specify the number of copies to be published for images.

Graphic

ICM Method

ICM Method Function

ICM Disabled Synchronized with “Color Adjustment Disabled” in the 2.2.4
Option.

ICM Handled by Host System Synchronized with “Color Adjustment ICM” in the 2.2.4
Option.
Manage colors using the driver.

ICM Handled by Printer When this item has been selected, operation is the same as
“ICM Handled by Host System”.

ICM Intent

Set the rendering method when using ICM. For the ICC profile, always set to “Pictures”.
Do not use other settings.

Document Options

Advanced Printing Features
Always set “Enabled”. Do not use other settings.

Pages per Sheet Layout
Set the layout direction of an image when the Pages per Sheet setting is set for multiple divisions.

Printer Features

Border
Synchronized with Border in the Option.

Overcoat Finish
Set the overcoat finish method for the surface of printed items from the following two types.

Overcoat Finish Function
Glossy Create an item with a glossy finish.
Matte Create an item with a matte finish.

18
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Print Re-try
Specify whether to print data in the printer buffer after a printer error has been cleared.
Print Re-try Function
Disable Clear the print data in the printer buffer when a printer error occurs.

You must send the cleared print data again after the error is cleared.
When you use an application with an error recovery function, select

this option.

Enable

Save print data in the printer buffer when an error occurs.
The printing process is restarted from the saved data after the error is

cleared.

Note that if the power is switched off, the data is not saved.

Depending on the printer error, print data in the print buffer will be cleared, regardless of the Print

Re-try setting.

The following section shows the operation for each Print Re-try setting by error.

Error content

When Print Re-try is “disabled”

When Print Re-try is “enabled”

Paper end

Ribbon end

You must send the unprinted
image data again after the error
is cleared.

The printing process is restarted
from the data saved in the printer
buffer after the error is cleared.

When the paper initialization
operation is to be carried out,
printing occurs afterwards.

To prevent the occurrence of an error, printing will not be restarted,
regardless of the Print Re-try function setting.

After the printer stops due to an error, follow the User Guide of the
printer to eliminate the cause of the paper or ribbon error.

You must send the unprinted image data again after the error is
cleared.

Because the printer must be switched on and off to clear the error, the
print data in the printer buffer is cleared regardless of the Print Re-try
setting.

Top Door open

No trash box

Paper jam

Ribbon error

Paper size setting error

System error
-Data error

*Head voltage error
After the printer has restarted, you must send the unprinted image

-Head position error data again.

- Cutter error
-Head temperature error
-Media temperature error

-RFID module error

-USB power supply
voltage error

19
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2inch cut
Specify whether to cut paper into multiple sheets with a 2-inch length when you use a specified
paper size.
2inch cut Function
Disable Cut at the normal size.
Enable Cut at 2-inch lengths so that the 4x4 size becomes two sheets

four sheets.

the 4x6, 4.5x6 size becomes three sheets and the 4.5x8 size becomes

In the case of 2inch cut, due to mechanical limitations, its edges can
cause slight image bleed.
It can be prevented by making the space between the images a single
color of about 3 mm as shown in the figure.

. amm Ao
4

3 mm

Cut when paper

Cut when paper
is ejected

2inch cut edges can cause
slight image bleed.

High quality mode

is ejected
3 mm t' :

X
v
e
'

3mm t--

Enables or disables high quality mode.

High quality mode

Function

Disable

Prints with normal quality.

Enable

Prints with high quality.-1)

*1: Printing time takes longer than printing with normal quality.

Decurling action
Set the decurling action.

Decurling action

Function

Disable

Does not execute the decurling action.

Enable

The decurling action is performed.

Auto

The printer automatically controls the decurling action depending on
the media status.

Be careful as paper may get caught under the lower part of the front surface of the printer when the

decurling action is disable.
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< Multiple layout >

You can enable multiple layout settings by setting the paper size of the printer driver. If it sends
multiple images from the application, the printer driver allocate them automatically as the multiple

layout.
The following section shows the image sizes.

Layout settings

Driver paper size setting dﬁ:&(ie(;n FEfREl S|ze(:ﬁnmg;th XAl Media used
(4x3) Portrait (107.2x79.3) 4x6, 4.5x8
Landscape (79.3x107.2)
Portrait (119.3 x79.3) 4.5x8
(4.5x3) Landscape (79.3 x 119.3)
Portrait (119.3 x 104.7) 4.5x8
(4.5x4) Landscape (104.7 x 119.3)

Note) Because they are carried out by the print job, multiple layout are carried out when there

are multiple images in a single job.

If you want to layout the same image, send the same number of images as the number-

of-sheets setting.

The printer handles two pictures at one time and cuts the paper after it is ejected.
In the case of Multiple layout,due to mechanical limitations, its edges can cause slight

image bleed.

It can be prevented by making the space between the images a single color of about 3

mm as shown in the figure, or by printing with borders.

Cut when
paper is ejected

Multiple layout cut edges can
cause slight image bleed.

<When the top and bottom are made
into a single color of about 3mm>

3mm #—

Multiple layout

3mm #-

Cut when
paper is ejected
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< Application usage example >
This usage example uses Windows Explorer.

Step 1. In Windows Explorer, select two or more pictures.

Next, click “Print”.

B B - | cameraRoll

Manage 3
Home  Share  View | Picture Tools N ]
« v < Pictures » Camera Roll v 0 2 Search Camera Roll

Open
Create a new video
Edit with Photos
Edit with Paint 3D
Tiger Set as desktop background
Edit
Rotate right
Rotate left

Select 2 or more images ~ pevice >

h Microsoft Defender...

[CITIZEN CZ-01 Printer Driver] Instruction Manual (For Windows 7, 10)

=3 -
2items 2 items selected 5.33 MB | = S ::

Step 2. Select “Fit picture to frame” check box, and
then click “Options...”.

X
=
How do you want to print your pictures?
Printer: Paper size: Quality: Paper type: P
CITIZEN CZ-01 V| @3 ~| 300 300dpi ~| | Plain Paper v

Full page photo

10f 2 pages

G

Copies of each picture: [ 1 |2]

Fit picture to frame

li‘Jgnons o '

Step 3. Click “Printer Properties...”.

Print Settings

Sharpen for printing

Only show options that are compatible with my printer

Certain combinations of paper type, paper size, and print quality may
not print well or be available with all printers. Limiting your options to
only those that are compatible will give you the best results.

Color Management...

Printer Properties...

Step 4. Set the Orientation to “Portrait”,
and click “Advanced...”.

{5 CITIZEN CZ-01 Printing Preferences

Layout  Paper/Qualty Option  Color Adustment  Printer Info

Orientation:

Portrait '

Page Order:

Front to Back v

Page Format

Pages per Sheet

Draw Borders

s

oK Caneel Aoply

Step 5. Set the paper size to the setting of the
multiple layout. Click “OK” twice to close
the dialog boxes in Step 5 and 4 and return
to the display in Step 2.

CITIZEN C

Advanced Options

= CITIZEN CZ-01 Advanced Document Settings
-4 | Paper/Output
Copy Count
E-@ Graphic
=] @ Image Colel

5¢3)
(4.5:4)
[4.5:4.5)
dled by Host System
«—

<: Enabled
ght then Down

1§y Printer Featl (446)
........ Border: Disable

Overcoat Finish: Glossy
........ Print Re-try: Enable

High quality mode: Disable
Decurling action: Auto

Step 6. Click the “Print” button.

How do you want to print your pictures?

Printer: Paper size: Quality:

Paper type:
CITIZEN CZ-01 I

300 300dpi ~ | |Plain Paper R

Full page photo

10f 2 pages ®

Copies of each picture: 2

Fitpicturetofame  Dption
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451 CITIZEN CZ-01 Printing Prefy

Layout  Paper/Qualty | Option Color Adjustment | Frinter Info
Colar

-g O Blagk & White -'f @ [Calon

Cancel Apply

Figure 2.2.3 Paper/Quality tab

Color

Set Color. Do not use black and white.

2.2.4 Option

B CITIZEN CZ-01 Printing Preferences

Layout | Paper/Qualty

Option  Color Adjustmert | Printer Info
[ Border

0 (Default)

(O Handled by Driver())
@ ICM) O ICM & Driver( (M)
Language(L) : English s
AboutiB)..
Default(D)
Cancel Apply
Figure 2.2.4.1 Option tab

Border

Enable/Disable in the Advanced settings.
Sharpness

Process sharpness using one of the 11 stages (Figure 2.2.4.2).
sharpness is not processed.

(+) side sharpens the image.

23

Specify a border for printing. (Select the check box for a border.)
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2.2.3 Paper/Quality

{2 CITIZEN CZ-01 Printing Preferences

Layout Peper/Quslity OPton  Dolor Adiustment  Printer Info
OBorder

Sharpness(H) :

0 (Defautt) v
O None) o

@M
Language(l)

About(B)...

Default(D)

Gancel Jpply

Figure 2.2.4.2 Sharpness setting

Synchronized with Border

If the setting is “O (Default)”,
Moving to the minus (-) side blurs the image and moving to the plus
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Color Adjustment

None
Synchronized with the ICM Method in the Advanced settings. If this check box is selected,
ICM is disabled, the Color adjustment tab is also disabled, and the printer driver does not
carry out color adjustment.

Handled by Driver
If this check box is selected, ICM is disabled, and the 2.2.5 Color Adjustment is enabled.
The result is applied to the adjustment values of the following items: Gamma, Brightness,
Contrast, and Chroma.

ICM
Synchronized with the ICM Method of the Advanced settings (ICM Handled by Host System).
If this check box is selected, the driver manages colors.

ICM & Driver
If this check box is selected, ICM (color management) and the 2.2.5 Color Adjustment are
enabled.

Language
Change the display language for the following items: Option, Color Adjustment, and Printer Info.
The selected language is enabled the next time the print settings are displayed.

[Available languages]
- Japanese
- English (US)
- French (France)
- German (Germany)
*+ Russian (Russia)
+ Spanish (Spain)
- Italian (Italy)
- Korean
- Chinese (People's Republic of China)
- Chinese (Taiwan)

+ When your operating system environment corresponds with one of the above settings, the default
display language is the language of the corresponding country. Furthermore, when your
operating system environment does not correspond with one of the above settings, the default
display language is English.

- To use a language different from that of your operating system, you must install the following font
for the corresponding language.

Language Font
Japanese Meiryo / Yu Gothic Ul <Windows10>
English (US) Segoe Ul
French (France) Segoe Ul
German (Germany) Segoe Ul
Russian (Russia) Segoe Ul
Spanish (Spain) Segoe Ul
Italian (ltaly) Segoe Ul
Korean Malgun Gothic
Chinese (People's Republic of China) Microsoft YaHei
Chinese (Taiwan) Microsoft JhengHei

About
Show the driver version.
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2.2.5 Color Adjustment

If the Handled by Driver check box is selected in the 2.2.4 Option, the adjustment values of the
Color Adjustment tab are applied to the image.

fm CIIZEN CZ-01 Printing Preferences

Layout Paper/Quaity Option Color Adustment  Prnter Ifo

Sample Picture

Default(D)
Load(L)...

Save(S)...

=

Figure 2.2.5 Color Adjustment tab

The following section shows the setting ranges on the Color Adjustment tab.

Adjustment item

Adjustment value

Gamma

-100 (dark) to 100 (bright) (“0” results in no adjustment, y2.0 to 0.5)
Adjust the density of the half-tone section of the image. Increasing the gamma value
brightens the half-tone section.
Sync check box
ON: Set RGB to same value.
OFF: Set RGB to different value.

Brightness

-100 (dark) to 100 (bright) (“0” results in no adjustment)
Adjust the brightness of the image. Increasing the brightness value brightens the
entire image.
Sync check box
ON: Set RGB to same value.
OFF: Set RGB to different value.

Contrast

-100 (weak) to 100 (strong) (“0” results in no adjustment)
Adjust the contrast of the image. Increasing the contrast value increases the
difference of brightness and darkness.
Sync check box
ON: Set RGB to same value.
OFF: Set RGB to different value.

Chroma

-100 (weak) to 100 (strong) (“0” results in no adjustment)
Adjust the chroma of the image.
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2.2.6 Printer information

View the printer information.

/mt CITIZEN €Z-01 Printing Preferences

Layout  Paper/Qualty Option  Color Adusiment | Printer Info
Media Info [ Premium Digital |
150 /150 Sheets
0% 0% 100%
Printer Status
‘Wa\tmg ‘
{ - ]
| ="
Total Count Firmuware Version
2001 CZ.010040
Serial No.
Color Control Data
Version Checksum
300dpi CZ01_PD_300_0031.CWD EACS
Low Speed CZ01.PD_310,0031.CWD CADO
Update(U)
o Bosly

Figure 2.2.6.1 Printer Information tab

45t CITIZEN CZ-D1 Printing Preferences

Layout Paper/Quality Option Color Adjustment  Printer Info

Media Info [ Premium Digits! ]
“- f - Sheets
0% 0% 100%
Printer Status
|Waltmg
{ - )
N2 Cncarecmenispe s been st >>
C—
Total Count Firmware Version
2991 €Z-0100.40

Color Contral Data

Version Checksum
300dpi CZ01_PD_300_0031.CWD EACS

Low Speed CZ01_PD_310_0031.CWD CADD

Update(U)

[ ok || Cancel Aeply

Figure 2.2.6.2 Display when
incorrect media is loaded

The following section shows the information displayed in the Printer Info tab.

Display item Display details

Media Info

This area shows, for example, the class, the size, and the remaining number
of printable sheets for the ribbon media in the printer.
* Media information is not displayed when a media type not supported by the
printer has been loaded. (Figure 2.2.6.2)

Printer Status

Displays the status of the printer using icons and characters.

Display icon  Display Status/Response
(Color) characters
lé Waiting Printing is possible.
(Green)
Printing The printer is printing.
N
EH
(Blue)
Top door open Top door is open.
Close the top door.
(Yellow)
Ribbon end No ribbon remains.
Load new media.
% (Replace the paper and ribbon as a set.)
(Yellow)
Paper end No paper remains.
Load new media.
(Replace the paper and ribbon as a set.)
-3
(Yellow)
26
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Display item

Display details

Printer Status

Display icon  Display
(Color) characters
Offline

Cooling head

QD 3 )

(Purple)
— Ribbon error

Y :ofb
(Orange)
— Paper size
‘;‘ { setting error
-
(Orange)
— Paper jam

1_|f

A
(Orange)
~ I

(Orange)

@ System error

—

No trash box

(Red)

Status/Response

The printer cannot be recognized.
Connect the printer and computer, and then
turn on the power.

The head is being cooled.
Please wait a while. Printing will resume
automatically.

The ribbon is not set correcily.
Reload the ribbon properly.

The printer settings and size of the installed
ribbon do not match.
Check the paper size setting and ribbon size.

A paper jam was detected.
Remove the paper and reload it properly.

The trash box is being detached.
Attach the trash box.

System error.

Restart the printer and computer. If the printer
does not recover after the restart, contact the
service center.

* A warning message is displayed when a media type not supported by the
printer has been loaded.(Figure 2.2.6.2)

Total Count Total count of printed sheets.

Firmware Version | Version of the control program of the printer. xx.xx indicates the version.
+ CZ-01 xx.xx

Serial No. Serial number of the printer.

Color Control Printer color control data.

Data
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2.3 Default values for settings

The following section shows the default values of the settings (at installation). If the settings have
been changed, and the printer driver no longer operates normally, return to the default values shown
below.

Note) Depending on the service pack of your operating system or your usage environment, the
default values at installation may differ from those in the chart below.

Chart 2.3 Default print settings

Tab Setting Value
Orientation Portrait
Layout Page Order Front to Back
Pages Per Sheet 1
Paper/Quality Color Color
Border Disable
. Sharpness 0 (Default)
Option Color Adjustment ICM
Language setting English
Gamma 0
Color Brightness 0
Adjustment Contrast 0
Chroma 0
. Depends on printer
Paper Size D aia (*
Paper/Output P ” media size (1)
Copy Count 1 Copy
ICM Handled by Host
Graphic :\;Inange Cr(;lo;t ICM Method System
Ad g anageme ICM Intent Pictures
vance .
settings Advanced Printing Features Enabled
(In the Layout Pages per Sheet Layout Right then Down
EaAb, click Border Disable
dvanced..”) Document Overcoat Finish Glossy
options Printer Print Re-try Enable
function 2inch cut Disable
High quality mode Disable
Decurling Action Auto

*1: For the initial values of paper sizes, see “2.2.2 Advanced options”.
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2.4 Color management

Use Color management to specify the color profile. The installer associates “SD_CZ01_xxxx.icc”
and “PD_CZ01_xxxx.icc” by default.

This printer driver automatically changes the color profile for the media that is loaded in the printer.

To use an ICC profile other than the default profile, overwrite the ICC profile that has been registered
as the default.

For the ICC profile to overwrite, prefix “SD_" to the profile name for Digital media and prefix “PD_" to
the profile name for Premium Digital media.

Example: Overwritten profile name
For Digital 1 SD_xxxxxxxx.icc

For Premium Digital : PD_xxxxxxxx.icc

Step 1. From the Printer Properties, Step 2. From Device, select CITIZEN CZ-
select the Color Management tab, and 01.
then click “Color Management...”.

{51 CITIZEN CZ-01 Properties

[ Color Management

General Sharing Ports  Advanced Color Management  Security Devices Alrofiles  Advanced

To adiust color management settings, cick Color Management
5 Device: Printer: CITIZEN CZ-01 v
s 2
ST —— s
Profile selection: Automatic (Recommended)
Profiles associsted with this device
Name File name
1CC Profiles
$D_C701 SD_CZ01
PD_CZ01] PD_CZ01;

icc
ice

ICC Prafiles (Advanced Color)

SD_CZ01 1 7018 Ricc

PD_CZ01; Cz01 B ice

The installer associated this file

Tad-. Femove Serac Default Profile

OK Cancel Zoply

Figure 2.4.1 Color Management Tab Figure 2.4.2 Color Management Window
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2.5 Print Area

The following section shows the image sizes and numbers of dots generated by the paper size setting

of the driver.

CITIZEN SYSTEMS JAPAN CO., LTD.

Brint Image size Number of image dots
rin
Paper size . (width x height) (width x height)
direction - i
(inch) (mm) 300x300dpi
(4x3) Portrait 4'x 37 107.2x79.3 1266 x 936
X
Landscape 3'x 4” 79.3 x 107.2 936 x 1266
(4xd) Portrait 4°x 47 107.2 x 104.7 1266 x 1236
X
Landscape 4’x 4” 104.7 x 107.2 1236 x 1266
Portrait 4°x 4.5 107.2x 117.4 1266 x 1386
(4x4.5)
Landscape 4.5'x 4” 117.4 x 107.2 1386 x 1266
(4x6) Portrait 4’ 6” 107.2 x 155.5 1266 x 1836
X
Landscape 6"x 4” 155.5 x 107.2 1836 x 1266
Portrait 4.5"x 3" 119.3 x 79.3 1408 x 936
(4.5x3)
Landscape 3'x 4.5” 79.3x119.3 936 x 1408
Portrait 4.5'x 4” 119.3 x 104.7 1408 x 1236
(4.5x4)
Landscape 4’x 4.5” 104.7 x 119.3 1236 x 1408
Portrait 45'x 4.5 119.3x 117.4 1408 x 1386
(4.5x4.5)
Landscape 45x4.5” 117.4 x 119.3 1386 x 1408
Portrait 4.5"x 6” 119.3 x 155.5 1408 x 1836
(4.5x6)
Landscape 6"x 4.5 155.5x 119.3 1836 x 1408
(4.58) Portrait 45" x 8 119.3 x 206.3 1408 x 2436
.5x
Landscape 8" x4.5” 206.3 x 119.3 2436 x 1408
30
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2.6 Orientation

The following chart shows the relationship of images generated by an application and printed items
(output direction) according to the orientation setting. Generated images are not the original image
rotated by the application but are zoomed to fit within the sizes is shown in “2.5 Print Area”.

Driver setting
Paper setting
Original (4x3), (4.5x3), (4.5x4) (4x4), (4x4.5), (4x6),
image | Orientation (4.5x4.5), (4.5x6), (4.5x8)
Generated Printed item Generated Printed item
image (Output orientation |) image (Output orientation |)
Portrait
Landscape
Portrait
Landscape
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Chapter 3 Update the driver

As when performing the installation, log in as an administrator before carrying out this operation.
1. Check the job

1) Before updating the printer driver, close all applications. Furthermore, click on the icon of the
printer to be updated in the Devices and Printers screen. At the bottom area of the screen,
confirm that there are no documents in the queue, and then start update of the driver.

Note: In Windows 10, when the printer is offline (the printer is not on and connected), the CITIZEN
CZ-01 icon is not displayed. Always connect the printer with the power turned on and
check that there are no documents in the queue.

nh Devices and Printers
« v 4 Fa « Hardware and S... » Devices and Printers v Search Devices and Printers

r
Add a device Add a printer Seewhat's printing Print server properties  » = - o

= =

CITIZEN CZ-01 Fax

~

CITIZEN CZ-01

Model: CITIZEN CZ-01
! Category: Printer

Status: 0 document(s) in queue

Figure 3.1 Clicking the CITIZEN CZ-01 icon at the Devices and Printers screen
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2. Uninstall the driver package

1)Click “Start”, and then click “Windows System” -> “Control Panel”. In the Control Panel, click
“Uninstall a program”.
In Windows 7, click “Start”, and then click “Control Panel”. In the Control Panel, click “Uninstall a
program”.

EE Control Panel

B Windows Media Codec Pack
« © 4 [ > Control Panel > v|@) | search Control Panel )

[Bl] Windows Media Player

File Edit View Tools
l Windows PowerShell

Adjust your computer's settings Viewby: Cat
B Windows System Just y P g iewby: Category ¥

Change date, time, or number formats
TaskWarioger ./ Hardware and Sound ’
View devices and printers
Add a device
Adjust commonly used mobility
settings

. Programs
[,l. Uninstzll a program

Get programs

Ease of Access
Let Windows suggest settings
Optimize visual display

This PC

Command Prompt ‘ System and Security User Accounts
Review your computer's status &
Change account type
Control Panel Save backup copies of your files with % ? e
File History B8 Appearance and
File Explorer Backup and Restore (Windows 7) Personalization
- —
Run ¢ Network and Internet lock and .
e 1Y
View network status and tasks :3 Clock and Region

Figure 3.2 Control Panel

2) The Uninstall or change a program screen appears. In the list, double click “CITIZEN CZ-01".

8] Programs and Features

« v 4 B‘ » Control Panel » Programs » Programs and Features v O Search Programs and Features 0

Control Panel Home .
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
) Tum Windows features on or
off Organize v Uninstall Change Repair B= - o
Name ~
& CITIZEN CZ-01
w
< >

CITIZEN SYSTEMS JAPAN Product version:  0.3.0.0
Help link:  http://www.citizen-systems.co.jp/

Figure 3.3 Uninstall a program
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3) Click “Yes” when the CITIZEN CZ-01 uninstall confirmation windows appears.
Uninstalling the driver is complete. After uninstalling the printer package, restart the computer.

Programs and Features

| Are you sure you want to uninstall CITIZEM CZ-017

[ In the future, do not show me this dialog box

Figure 3.4 Uninstallation confirmation

When a User Account Control dialog box appears, click “Yes”.

User Account Control *
Do you want to allow this app from an
unknown publisher to make changes to your
device?

[ o "wln T msi

Publisher: Unknown
File origin: Hard drive on this computer

Show more details
[ Yes ] No |

Figure 3.5 User Account Control

3. Install an upgrade for the printer driver

After deleting the printer and the printer driver, install the new printer driver. For the installation
procedure, see “Chapter 1 Installation”.

4. Restart the computer

After the installation of the printer driver is complete, always restart the computer.
(Do not print just after installation. Always restart the computer once.)
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Chapter 4 Delete the driver
4.1 Automatic deletion of printer drivers

The printer driver is automatically deleted when uninstalling the driver package.
For the steps to uninstall the driver package, see “2. Uninstall the driver package” in Chapter 3.

Note that uninstalling the driver package when the printer driver is in use will display the following
message, and the printer driver will not be deleted.

CITIZEN CZ-01 Printer Driver Uninstaller

:' The specified printer driver is currently in use.
4

Figure 4.1 Message displayed when the driver is in use

When the above message is displayed, restart the computer and then delete the printer driver using
the procedure described in “4.2 Manual deletion of printer drivers”.
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4.2 Manual deletion of printer drivers

1)Click “Start”, and then click “Windows System” -> “Control Panel”. In the Control Panel, click
“View devices and printers”.

In Windows 7, Click “Start”, and then click “Control Panel”. In the Control Panel, click “View
devices and printers”.

From the Devices and Printers screen, right click the CITIZEN CZ-01 printer. From the menu,
click “Remove device”.

nt Devices and Printers

- v /4 Fa » Control Panel » Hardware and Sound » Devices and Printers v @ Search Devices and Printers

r
Add a device Add a printer See what's printing Print server properties Remove device =] o

e See what's printing
t Set as default printer
Printing preferences

Printer properties
CITIZEN CZ-01

Create shortcut

9 Remove device
TrouBleshoot

Properties

CITIZEN CZ-01

Model: CITIZEN CZ-01
: Category: Printer

Status: 0 document(s) in queue

Figure 4.2.1 Right clicking CITIZEN CZ-01 in the Devices and Printers screen
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In Windows 10, when the printer is offline (the printer is not on and connected), the CITIZEN CZ-
01 icon is not displayed. In such cases, use the following procedure to delete the device.

(i) On an empty area in the Devices and Printers screen, right click, and then select “Device

Manager”.
View >
Sort by >
Group by >
Refresh
Paste

Paste shortcut

Add devices and printers

Device Manager
g

Figure 4.2.2.i Right clicking on an empty area in the Devices and Printers screen

(ii) Click “View”, and then select “Show hidden devices”.

o Device Manager
File Action | View Help

4= = | | |8 Devices bytype
Devices by connection
Devices by container
Resources by type
Resources by connection

" Show hidden devices

Customize...

Figure 4.2.2.ii Displaying the View menu for hidden devices

(iii) Under “Printers”, right click “CITIZEN CZ-01”, and then select “Uninstall device”.

ﬂ Device Manager

File Action View Help
= @FEHE B EX®

~ [ Printers
= CITIZEN CZ-01

L] Processors Update driver
B Software devices Disable device
i| Sound, video and Uninstall device )

c.’* Storage controllers
§3 System devices
i Universal Serial Bu Properties

Figure 4.2.2.iii Displaying the menu to delete CITIZEN CZ-01

Scan for hardware changes

(iv) At the “Uninstall Device” screen, click “Uninstall”.

Uninstall Device

==  CITIZEN CZ-01
==

Waming: You are about to uninstall this device from your system.

[0

Figure 4.2.2.iv Uninstall Device screen
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2) The printer deletion confirmation dialog box appears. Click “Yes”.

= Areyou sure you want to remove this device?

CITIZEN CZ-01

Yes

Figure 4.2.3 Printer deletion confirmation dialog box

3) After deleting the CITIZEN CZ-01 printer, select another printer (for example, Fax), and then click
“Print Server Properties” in the menu bar.

ity Devices and Printers

- “ P e « Hardware and Sound » Devices and Printers v @ Search Devices and Printers 02

File Edit View Tools

Add a device Add a printer See what's printing Remove device =] o

L

Fax Model Microsoft Shared Fax Driver
@ Category: Fax
Status: 0 document(s] in queue

Figure 4.2.4 Displaying the Print Server Properties menu in the Devices and Printers screen
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4) The Print Server Properties dialog box appears. Click the “Drivers” tab. From the installed
printer driver list, select “CITIZEN CZ-01”, and then click “Remove...”.

!;! Print Server Properties

Forms  Parts ecunty Advanced

d

Installed printer drivers:

Mame Processor Type

CITIZEN CZ-01 xE Type 3 - User Mode

GChange Driver Settings

Cancel Apply
Figure 4.2.5 Printer Server Properties dialog box

5) The Remove Driver and Package dialog box appears. Select “Remove driver only”, and then
click “OK”.

Remove Driver And Package

Do you want to remove the driver(s) only, or remove
the driver(s) and driver package(s) from your system?

(e )

() Rernove driver and driver package.

Figure 4.2.6 Remove Driver And Package dialog box
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6) The Print Server Properties confirmation dialog box appears. Click “Yes”.

Print Server Properties

|\ Deleting this printer driver will remove it
from the system. Are you sure you want
to delete CITIZEN CZ-017

Yes No

Figure 4.2.7 Driver deletion confirmation dialog box

If the following message appears, the operating system may be using the driver (Print Spooler
service) in the background. Disconnect the USB cable and then restart your computer and try
deleting the printer driver again.

Print Server Properties

9 Unable to remove CITIZEN CZ-01, x86,
Type 3 - User Mode driver.

The specified printer driver is currently in
use.

Fig4.2.7.i Driverin use

7) In the Print Server Properties dialog box, confirm that CITIZEN CZ-01 was deleted, and then click
“Close”.

fmt Print Server Properties

Forms  Pots  Drivers  Security Advanced
?

Installed printer drivers:

Mame Processor Type

Qchange Driver Settings
Cancel Apply
Figure 4.2.8 Print Server Properties
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